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Foreword 
 
The Eigenharp represents a new generation of expressive musical instru-
ment which you could describe as “on beyond MIDI”. 

The Eigenharp is properly termed a “controller”, i.e. an input device 
which doesn’t generate musical sounds by itself, but sends signals to 
software running on a computer which does. The sound-producing 
software for the Eigenharp is called EigenD, which (at the time of writing) 
is in the process of becoming open-source. 

EigenD is a collection of  components, called agents, which govern 
specialized functions, such as sound generation, key assignment and the 
user interface to the instrument, whether computer or keyboard. In a 
sense, EigenD consists of nothing but agents. Third-party software 
developers can write agents, and are encouraged to do so. 

One noteworthy agent is the Belcanto Interpreter. This implements a 
specialized configuration language called Belcanto, having these design 
goals: 

• Can configure the Eigenharp in all its aspects. 
• Can be entered from the Eigenharp keyboard as a sequence of 

musical notes. 
• Can also be written down and executed as an ASCII script. 
• Can be understood by a musician without programmer 

training. 
Belcanto has evolved considerably in its first decade of life. It depends 
for its form and structure on the individual agents which it configures. 
Since these agents have been written by different people following a loose 
set of guidelines, Belcanto is not like other computer languages that have 
been designed as an integrated whole. So the definitive Belcanto 
reference manual may never be written. This has led to a gap in 
instructional material which this book tries to fill. 

This Cookbook is not a formal treatment of Belcanto as if it were yet 
another programming language. It is addressed to musicians, not pro-
grammers. It is not a user guide, nor a primer, nor a reference manual: it 
is a collection of Belcanto recipes contributed by different musicians, or 
more generally, a collection of tricks and techniques for configuring the 
Eigenharp. You can use it, in conjunction with the vendor’s own docu-
mentation, to bend the Eigenharp to your will. It is a starting point for 
your own experiments. We have, however, tried to add sufficient explan-
ation for you to start using it, even if you know virtually no Belcanto. 
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If you are non-technical, there is a glossary of technical terms at the 
back (Appendix A). There is also a reference list of selected Belcanto 
words (Appendix B). We haven’t covered them all (there are over 700) 
but just the main ones which won’t be obvious to the beginner. Thus a 
Belcanto word like octave requires no explanation to a musician, 
whereas ify and un might well do so. 

A “cookbook” could so easily be a mere rag-bag of recipes, with no 
threads to pull different themes together. We’ve tried to avoid this by 
imposing a common structure on the recipes we’ve got from various 
sources. General principles are explained where appropriate, and some 
cross-referencing has been attempted.  

The aim of all this has been to help you browse the recipes with some 
special task in mind: some problem of your own to solve. But do bear in 
mind that the structure of this cookbook arises out of the recipes we’ve 
been offered, not the other way round. This is the opposite to a typical 
manual for a programming language, in which examples would be chosen 
to fit the way the author wants to expound the principles. 

Doing it our way means that our recipes are more likely to be useful 
to you straightaway than the abstract examples you’d see in a formal exp-
osition. There is a down-side however. When you come to adapt a recipe, 
you may need to play around a bit to find out what works and what 
doesn’t. Where Belcanto is concerned, it’s hard to do anything else. A 
Belcanto phrase is highly context-dependent: it depends on the setup you’re 
starting with, the instrument you’re using (Alpha, Tau or Pico), and 
whatever other Belcanto has preceded it. 

None of the recipes can be guaranteed, alas. But all of them have been 
verified to work, if only with the stated setup, Eigenharp model and level 
of EigenD (2.0.74 at the time of writing). Unless explicitly stated, each 
recipe is for the Pico, but can be adapted to other models with the applic-
ation of some creativity. 

 
Ian Clark 
Whitby, 2013 
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1  Getting started with Belcanto 

1.1  To get ready to run the examples in this chapter 
Before you run the examples in this chapter, do the following: 

• Launch EigenD from the Apple® Macintosh™ Dock. 
• Load factory setup pico 1, the Pico Standard setup 

Factory Setups > pico > 1 (Standard Setup) 
 

 
 

• Plug your Eigenharp into a USB port. 
• Launch EigenBrowser from the EigenD menubar 

Menu: Tools > EigenBrowser  ⌘B 
• Launch EigenCommander from the EigenD menubar 

Menu: Tools > EigenCommander  ⌘C 

1.2  A useful test expression in Belcanto 
You'll find the following Belcanto phrase useful as a general-purpose test 
when experimenting with scripts and talkers. 

To start/stop the metronome: 
 
metronome hey toggle start 
 

This provides instant audible feedback of successful execution, it will 
work in any setup where the agent: metronome is present, and it doesn’t 
require the Eigenharp to be attached. 

The agent: metronome doesn’t just control the metronome tick, but 
starts and stops percussion loops too. 

Note that the above phrase can be split over two lines, like this: 
 
metronome hey 
toggle start 
 

Conversely any block of Belcanto phrases can be run together into a 
single phrase all on one line. In other words, the Belcanto interpreter 
ignores ends of lines, tabs, etc (collectively called whitespace). 
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1.3  The different ways of  executing Belcanto code 
The main ways of composing and executing Belcanto code are: 

• Typing into EigenCommander. 
• Creating and running a script. 
• Playing on the Eigenharp keys themselves. 
• Inserting into the action field(s) of a given talker (using either 

EigenCommander or Workbench). 
• Executing as a Unix expression using command: brpc. 

The first two ways are the ones we shall be mainly concerned with. 

1.4  To type Belcanto into EigenCommander  
This is the recommended way of composing and debugging Belcanto 
expressions before using them elsewhere, e.g. in a script or in Workbench. 
It is far from being the most convenient way of handling Belcanto 
expressions (the user interface is idiosyncratic and does not conform to 
Apple® standards) but it analyses input into phrases, reports errors and 
makes a guess at why an error has occurred. 

Launch EigenCommander: Menu > Tools > EigenCommander ⌘C 
 

You see a 3-pane screen, the lower 2 panes looking like this: 

 
 
>_ shows the point where you start typing. 

Get in the habit of clicking this pane before typing. Unlike most Mac-
intosh software, the appearance of EigenCommander does not change 
when it is deselected, so often nothing happens when you type (or else 
the typing appears in the wrong window). 

Type: metronome hey start and press Enter. 
The sound of percussion should start. 
Type: metronome hey stop and press Enter. 
The sound of percussion should stop. 
The lower 2 panes should now look like this: 
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Note that acknowledgement messages have appeared in the right-hand pane. 
If the phrase failed, the message is in red. 

 
ASIDE: a quick way of repeating a phrase in slightly different form is to 
press the up-arrow on the keyboard (repeatedly), to make previous line(s) 
appear, then to backspace out the word: start (say) and then type: stop. 

1.5  To verify you do actually have version 2.0.74 running 
This is something you’ll only need to do if you’re troubleshooting a 
recipe. 

However you’ll be troubleshooting a lot when experimenting with Belcanto, so it’s wise 
to do it once, now, so you know how to do it when you need to. 

Once EigenD has been installed, you’ll see not one but two entries in the 
folder: /Applications/ viz. EigenD.app and a folder: /Eigenlabs/. 
In normal operation, you’d drag’n’drop the first item, EigenD.app, 
down onto the Dock, which ensures that this precise copy of the app is 
what gets launched when the Dock icon is clicked. 

Let’s open /Eigenlabs/ and, inside it, the folder: /2.0.74-stable/ 
(called the version folder): 
 

 
Inside, you can see another EigenD.app !! What’s going on? 
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There happens to be an EigenD.app in every version folder. These 
enable you to run any version of EigenD you’ve got installed. However 
each time you install a new version of EigenD, say 2.0.74, the 
EigenD.app residing directly in  /Applications/ is replaced with a 
copy of /Applications/Eigenlabs/2.0.74-stable/EigenD.app. 
This ensures that when you upgrade EigenD, it’s the latest version that 
gets launched by Dock without you having to do anything special, like pouf 
the old Dock icon and find the correct new app to drag’n’drop into Dock. 

However, this is exactly what some people do, with the result they can 
unwittingly be running the wrong version of EigenD. 

That’s the reason for this recipe, and the next one. 
Click the EigenD icon in Dock to make sure the correct menubar is 

showing. Then choose menu: File > About eigend 
 
This is a weird place for it, and easy to miss. You’d expect to find the About window either 
at menu: Help > About EigenD... or at menu: EigenD > About EigenD... 
 

 
 

If you don’t see this window, confirming that 2.0.74-stable is the 
version that’s running, then either check it is installed (see 1.6) and launch 
it, or be prepared to adapt the recipes to the version you’re running. 

Typically this means replacing 2.0.74 or 2.0.74-stable wherever you see it with 
the version number you actually see in the About window. 

1.6  To verify you do actually have version 2.0.74 ins tal l ed  
Click the EigenD icon in Dock to make sure the correct menubar is 
showing. Then choose menu: File > About eigend 

With Mountain Lion (OS X 10.8), Apple® have taken the “helpful” 
decision to hide the folder: /Users/yourname/Library/. This makes it 
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needlessly hard to navigate in Finder to the folder: /Eigenlabs/ 
contained within /Library/. However EigenD has a tool to do precisely 
that (though you might not guess it from its name): 

Menu: Tools > Open Library Directory 
This shows you a list of folders, one for each version of EigenD installed. 

 

 
Ignore the colors on the file items: the user has set these for his own convenience. 

 
This serves to confirm that the folder: /2.0.74-stable/ is actually 
present. It also shows you a list of other working folders, with names like 
/Audio/, /Setups/, etc., that are version-dependent. We have opened 
/2.0.74-stable/ and navigated to the folder: /Audio/ to reveal the 
file: audio.wav it can contain. You will need this task for recipe 7.1. 

1.7  To create and execute a Belcanto script 
Create a text-only file using your preferred method (e.g. Apple® TextEdit, 
or Windows™ NotePad) containing this text: 

 
name 
 test name 
description 
 This section describes what the script does, 
 viz it starts/stops the metronome. 
script 
 metronome hey 
 toggle start 
 

and save it as mytest.txt in the folder: 
/Users/yourname/Library/Eigenlabs/Scripts/ 

 
The filename does not matter. The Belcanto Interpreter uses the name inside the script, viz. 
test name. 
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Now run your new script by repeatedly executing this Belcanto phrase: 

 
e.g. by typing it into EigenCommander: 
 
interpreter 1 hey test name execute 

 
EXPLANATION: a Belcanto script is a vehicle for delivering Belcanto 
code for any purpose you like. It is a text-only file. Such files typically have 
the extension: .txt but a script can have any extension. It must contain 
ASCII characters only (no Unicode or utf-8). It must reside in the 
/Eigenlabs/Scripts/ folder. 

A script has a header and a script section. The header describes what it 
does. This is mandatory, even though it is not executed by the Belcanto 
interpreter. It starts with the word: name or description and finishes 
with the word script. Unlike Belcanto itself, whitespace does matter in 
the header. In particular, each of the section titles: name, description 
and script needs a line to itself. 

The name section is needed if you want to execute the script using 
Belcanto. The name must be a valid Belcanto noun (the filename won’t 
do). The name section may be placed above or below description. Or 
it can be omitted, like this: 

 
description 
 This section describes what the script does, 
 viz it starts/stops the metronome. 
script 
 metronome hey 
 toggle start 
 

You can select and execute a script by using EigenBrowser. In factory setup 
pico 1 there is a key: Browse Scripts in 4. Instrument / FX Control. This 
shows a list of scripts, which you can select (“arm”) and then execute. 

1.8  To pick a valid name for a given Belcanto script 
A script name must be a Belcanto noun. It may consist of one or more  
Belcanto words, including numbers. Take care to avoid the words set, to,  
from... or any other which might trick the Belcanto Interpreter into 
thinking the name has ended prematurely. If a given name doesn’t work, 
this may be the reason, so pick a safe one. Numbers are safe. 

Examples of a suitable name: 
 
punk 
12345 
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04 script 
test name 
acid attack 999 
 

Here is a list of Belcanto words ≤5 chars long, from which words can be 
chosen for a name: 
 
acid add again agent amber angle as at attack audio auto 
axis back band bank bar base basic bass beat bend blank 
blink blow blue blues bongo bow bus by cant chop chord 
clear clip close copy cubic curve cutoff cycle dance 
delay decal disco do dont down drum dry dub empty end eq 
event fade find fix flash folk foot for funk gain gate 
get gray green grey group gypsy hard harp help hey hi 
hold host id ify image in into isnt it iyot jazz join key 
label latch latin layer left light limit list load loft 
logo loop low lurk m map marva metal meter micro mid midi 
minor mix mixer mode mono move mute name next noise none 
note notea notes noun of off on once open organ pa pad 
page pan part pass pb pd pe pedal pelog pfcg piano pico 
pitch play pop port power pulse punk quote range rap rate 
re red re reset rest retro rig rock roll root row run 
salsa save sax say scale scan scope send setup show sine 
size ska soft song soul staff start step stop strip strum 
super swing switch synth table tail take tango tap taps 
tau test text time tin tone tonic top treble tree tune 
type ultra un undo unit until up use user using verb view 
viola vocal voice vu wait wet when which whole width with 
word yaw 





2  Building and using setups 
 
When you launch EigenD, it shows you a list of the setups it knows about, 
in a treeview window. This is a standard type of Mac window which lets 
you click a box containing a +-sign to expand that row as the branch of a 
tree. At the “leaves” of the tree are the names of the setups you can 
choose to load. 

 
Two factory setups of prime importance to the Pico owner are pico 1 (the 
so-called Pico Standard Setup) and blank. Both can serve as the basis for 
building your own setups. 

2.1  To load a given factory setup 
This ought to work, but doesn’t (under 2.0.74): 

 
pico 1 load 
 

A workaround is to load factory setup pico 1 using the EigenD main 
window, then save it as a user setup with the name unchanged. Then the 
above Belcanto phrase will work. 

2.2  To save the current setup under a new name 
Let’s make a small change to pico 1 and save it under a new name. 

 
An easy change to make to the setup is to use the Key Control (as explained in the Pico 
Quick Reference Guide, which comes with the instrument) to change the key to D. 
 

Click the button: Save As 
EigenD invites you to save the setup under a name it generates for you, 

viz. user 1 (...numbered all the way up to user 9) 
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On the face of it, this seems to limit us to only 9 user setups! 
However we don’t have to use the Belcanto word: user as part of our setup name. 
So in fact we can save a virtually unlimited number of user setups. 
 

Click the option: Belcanto Name as Words: and replace the word: user 
with another choice of Belcanto word, or words, e.g. gothic flash 

 
Pick words from the list displayed by EigenCommander. 
 

 
 

Click the button: Save 
 
Notice how the EigenD treeview now looks... 
There is now a new branch: gothic with a sub-branch: flash 
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2.3  To load a given saved setup 
To load a choice of setup, (e.g. the one you created above, named: gothic 
flash 1), execute the Belcanto phrase (e.g. by typing it into 
EigenCommander): 

 
gothic flash 1 load 
 

To reload the factory setup pico 1, execute the Belcanto phrase: 
 
pico 1 load 
 

For this to work, you might find you need to load factory setup pico 1 and save it again, 
thus making a copy that is now a user setup. 

2.4  To save a given setup plus the result of  running a 
given script 
After you’ve run the script, either click the button: Save in EigenD or, if 
you want to keep both the before- and after- setups, follow recipe 2.2. 

The point to emphasize is: once you run a script, it becomes part of 
the setup. This, once saved, can be reliably reloaded. 

If you have a collection of scripts which modify a given setup, 
consider saving the result of running each script as a separate setup. Find 
whatever works for you (a) as a setup developer, (b) as a performer. 
Keeping a collection of mix’n’match scripts favors (a), assembling a 
collection of tried-and-tested setups for your gig favors (b). 

2.5  To pick a valid name for a setup 
A setup name must be a Belcanto noun. The same rules apply as for 
naming a script. See recipe 1.8. 





3  Setting and adjusting scales 

3.1  To alter the octave buttons to transpose by a tritone 
In the factory setup pico 1, the two octave buttons transpose the current 
scale up by one octave, and back down again. 

Here’s a script to alter the octave buttons to transpose up instead by a 
tritone (or diminished fifth), and back down again: 

 
description 
  Make the Pico octave buttons transpose 
  the key up/down by a tritone instead. 
  [after: eigenlabs.com] 
 
script 
  octave talker hey 1 called 1 cancel 
  octave talker hey 2 called 1 cancel 
  octave talker hey 
    " main keygroup hey octave by 0.5 down " 
    when 1 called 1 do 
  octave talker hey 
    " main keygroup hey octave by 0.5 up " 
    when 2 called 1 do 

3.2  To transpose by some other interval than a tritone 
The tritone may not be your favorite choice of transposition. But it has a 
nice simple octave factor, viz. 0.5. Also, as you’ll find out when trying out 
the script, it’s the handiest for remembering which key you’re in. Press the 
button twice and you’re back to the original tonic note, except it’s now 
an octave higher (or lower). 

You can alter the script of 3.1 to make it transpose by a different 
interval. Just replace the octave factor 0.5 (in both places) by: 

Two octaves: 2 
One octave: 1 (restores the octave buttons’ original behavior) 
Major 7th: 0.91666666666666663 
Minor 7th: 0.83333333333333337 
Major 6th: 0.75 
Minor 6th: 0.66666666666666663 
Perfect 5th: 0.583333333333333333 
Tritone: 0.5 
Perfect 4th: 0.416666666666666667 
Major 3rd: 0.33333333333333331 
Minor 3rd: 0.25 
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Major 2nd: 0.16666666666666666 
Minor 2nd: 0.083333333333333329 

3.3  To restore the octave buttons’ original behavior 
You can restore the octave buttons’ original behavior following a 
transposition using recipe 3.1 by setting the octave factor to 1 in 3.1. 

Or you can omit the octave factor altogether. Thus in 3.1, replace: 
 
  " main keygroup hey octave by 0.5 down " 
 
  " main keygroup hey octave by 0.5 up " 
 

by: 
 
  " main keygroup hey octave down " 
 
  " main keygroup hey octave up " 
 



4  Mapping the keys  
 
There are two kinds of mapping used by the keygroup agent to define the 
note a given key plays, or the action a given key does (i.e. what Belcanto it 
talks when pressed): 

• physical mapping: defines a block of keys on the physical keyboard, 
• musical mapping: defines how notes are allocated within the block. 

The agent main keygroup in factory setup pico 1 treats all 18 keys as a 
single block, from which both music keys and action keys are allocated. 
When modifying pico 1 to experiment with different key arrangements 
it’s best not to interfere with this overall block, which means leaving the 
physical mapping unaltered, and altering only the musical mapping. 

The Pico’s physical keys are identified by their row and column thus: 

 
The four round buttons are honorary “keys” too, and reside in a notional 
Column 3. Calling them by their usage in pico 1, their row numbers are: 

1 Metronome 
2 Mode 
3 Octave down 
4 Octave up 

The physical mapping refers to keys by: [column, row]. But the 
musical mapping refers to keys by their ID number, preceded by their 
“course number”, which in pico 1 is always 1. Thus: [course, key]. 
Therefore in the following recipes, which only set the musical mapping, 
always read: [1,3] as the ID number: 3. NOT as: row 3 in: column 1. 

4.1  To make main keygroup play music on all 18 keys 
  
main keygroup hey 
musical mapping to " [] " set 
 

This is functionally equivalent to: 
  
main keygroup hey 
musical mapping to [ 
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 [[1,1],[1,1]] 
,[[1,2],[1,2]] 
,[[1,3],[1,3]] 
,[[1,4],[1,4]] 
,[[1,5],[1,5]] 
,[[1,6],[1,6]] 
,[[1,7],[1,7]] 
,[[1,8],[1,8]] 
,[[1,9],[1,9]] 
,[[1,10],[1,10]] 
,[[1,11],[1,11]] 
,[[1,12],[1,12]] 
,[[1,13],[1,13]] 
,[[1,14],[1,14]] 
,[[1,15],[1,15]] 
,[[1,16],[1,16]] 
,[[1,17],[1,17]] 
,[[1,18],[1,18]] 
] set 
 

EXPLANATION: If the specified musical mapping consists of the empty 
array [], then every key is mapped by default onto itself. Provided all 18 
keys have been specified in the physical mapping, then the default musical 
mapping is: 

This recipe serves to illustrate a principle rather than be of practical use 
in the context of pico 1.  

Now the keys in rows 8 and 9 not only play notes, but also talk 
Belcanto, because we’ve done nothing to detach them from their talker 
agents. The recipes below are more useful in practice because they make 
sure keys 9 and 18 don’t play music. 

4.2  To silence the last 2 keys of main keygroup 
  
main keygroup hey 
musical mapping to [ 
 [[1,1],[1,1]] 
,[[1,2],[1,2]] 
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,[[1,3],[1,3]] 
,[[1,4],[1,4]] 
,[[1,5],[1,5]] 
,[[1,6],[1,6]] 
,[[1,7],[1,7]] 
,[[1,8],[1,8]] 
,[[1,10],[1,9]] 
,[[1,11],[1,10]] 
,[[1,12],[1,11]] 
,[[1,13],[1,12]] 
,[[1,14],[1,13]] 
,[[1,15],[1,14]] 
,[[1,16],[1,15]] 
,[[1,17],[1,16]] 
] set 
 

This rearranges the keys (by ID number) like this: 

EXPLANATION: Notice that the first 8 lines of the musical mapping 
are trivial, i.e. they replace key 1 by key 1, key 2 by key 2, and so on. 
The first line that’s different is: [[1,10],[1,9]], which means: replace 
key 10 by key 9. The remaining keys (10-16) are likewise shifted up by 
one position. But what were key 9 and key 18 (in their old positions) 
don’t get replaced by any key. So they stay silent. 

That’s how pico 1 stops the last two keys (in row 9) playing music, 
leaving them free to talk Belcanto, and so become Scroll Key 1 and 2. 

4.3  To restore the original mapping of main keygroup 
  
main keygroup hey 
musical mapping to [ 
 [[1,1],[1,1]] 
,[[1,2],[1,2]] 
,[[1,3],[1,3]] 
,[[1,4],[1,4]] 
,[[1,5],[1,9]] 
,[[1,6],[1,10]] 
,[[1,7],[1,11]] 
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,[[1,8],[1,12]] 
,[[1,10],[1,5]] 
,[[1,11],[1,6]] 
,[[1,12],[1,7]] 
,[[1,13],[1,8]] 
,[[1,14],[1,13]] 
,[[1,15],[1,14]] 
,[[1,16],[1,15]] 
,[[1,17],[1,16]] 
] set 
 

To see how this works, refer to the explanation in recipe 4.2. 

4.4  To zigzag the keys in main keygroup 
  
main keygroup hey 
musical mapping to [ 
 [[1,1],[1,1]] 
,[[1,10],[1,2]] 
,[[1,2],[1,3]] 
,[[1,11],[1,4]] 
,[[1,3],[1,5]] 
,[[1,12],[1,6]] 
,[[1,4],[1,7]] 
,[[1,13],[1,8]] 
,[[1,5],[1,9]] 
,[[1,14],[1,10]] 
,[[1,6],[1,11]] 
,[[1,15],[1,12]] 
,[[1,7],[1,13]] 
,[[1,16],[1,14]] 
,[[1,8],[1,15]] 
,[[1,17],[1,16]] 
] set 
 

This rearranges the keys (by ID number) like this: 

To see how this works, refer to the explanation in recipe 4.2. 
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4.5  To set a given block of  keys to your own custom scale 
Edit the text-only file: User Scales.txt in the folder: 
/Users/yourname/Library/Eigenlabs/Scale Manager/ 
to add these lines to the bottom of the file: 

 
[17-tone equal temperament] 
; This is the 17-tone equal temperament scale 
; Taken from:  
; http://www.eigenlabs.com/wiki/Custom_Scales/ 
intervals=0 0.7059 1.4118 2.1177 2.8236 3.5295 
4.2354 4.9413 5.6472 6.3531 7.0588 7.7649 8.4708 
9.1767 9.8826 10.5885 11.2944 12 
 

Recipe 1.6 shows you how to find the folder: /Library/Eigenlabs/ 
Note: the interval= line should be a single line with no line-break, but shown here 
spilled over separate lines. 
Note also: lines beginning with semicolon are comment lines, disregarded by EigenD. 

Now (re)start EigenD. You now have a new custom scale called 17-tone 
equal temperament., which you can use as instructed by the vendor. 

The point of this recipe is to stress that the interval defining a note 
can be fractional, and thus can be chosen to represent a note of any 
desired pitch. The article: www.en.wikipedia.org/wiki/Note explains how 
to calculate fractional intervals from frequencies given in Hz (cycles-per-
second), or from precise ratios of other notes as used in classical tuning 
systems. 

4.6  To find the interval to use in your own custom scale 
Suppose cell: A1 contains whatever value we happen to know for the 
note. Shown below are Microsoft Excel™ formulas for the numbers in 
recipe 4.5. 

Copy/paste whichever formula you need into any Excel™ cell: 
(1) If A1 is note-frequency (Hz): 

=9+12*LOG(A1/440,2) 
(2) If A1 is frequency ratio with Concert Pitch, A440: 

=9+12*LOG(A1,2) 
(3) If A1 is frequency ratio with Concert Middle-C: 

=12*LOG(A1,2) 
(4) If A1 is the MIDI number (or MTS number): 

=A1-60 
(5) If A1 is the (fractional) octave above Concert Pitch, A440: 

=9+12*A1 
(6) If A1 is the (fractional) octave above Concert Middle-C: 

=12*A1 
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(7) If A1 is the (fractional) semitones above Concert Pitch, A440: 
=9+A1 

(8) If A1 is the (fractional) semitones above Concert Middle-C: 
=A1 

(9) If A1 is the number of musical cents (¢) above Concert Pitch A440: 
=9+(A1/100) 

(10) If A1 is the number of musical cents (¢) above Concert Middle-C: 
=A1/100 
 

EXAMPLE 1: In recipe 4.5 we know the first interval precisely: it is a 
fractional octave (one-seventeenth) above Concert Middle-C. Therefore 
we use (6), fractional octave, replacing A1 by (1/17) to give:  

 
=12*A1 
=12*(1/17) 
0.7059 
 

Successive notes of the scale then go up by this value: 0.7059, until we 
reach 12 semitones (= 1 octave), viz. 

 
0.7059 + 0.7059 = 1.4118 
0.7059 + 0.7059 + 0.7059 = 2.1177 
0.7059 + 0.7059 + 0.7059 + 0.7059 = 2.8236 
... 
 

EXAMPLE 2: Suppose we want a scale based not on A440 but on 
Scientific Middle-C. We know its exact frequency: 256 Hz. So we use (1), 
note-frequency, replacing A1 by 256 to give:  

=9+12*LOG(A1/440,2) 
=9+12*LOG(256/440,2) 
-0.3763 

Successive notes of the scale then go up by 1, as usual for a well-
tempered 12-tone scale, viz.  

-0.3763 + 1 = 0.6237 
-0.3763 + 1 + 1 = 1.6237 
-0.3763 + 1 + 1 + 1 = 2.6237 
... 

4.7  To reverse the note sequence of  the chromatic scale 
Edit the text-only file: User Scales.txt in the folder: 
/Users/yourname/Library/Eigenlabs/Scale Manager/ 
to add these lines to the bottom of the file: 

 
[Reverse Chromatic] 
intervals=12 11 10 9 8 7 6 5 4 3 2 1 0 -1 -2 -3 
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Now (re)start EigenD. You now have a new custom scale called Reverse 
Chromatic that makes the 16 music keys of factory setup pico 1 play 
chromatic notes in descending order. 

This recipe is offered as the basis for allocating notes taken from the 
chromatic scale to keys in any order you like, without redefining the 
musical mapping. It’s best to have precisely 16 numbers in your custom scale, 
to take control of the 16 music keys of pico 1. To achieve that, this 
recipe uses intervals that descend past 0 into negative numbers. 

EXPLANATION: A user scale can have any number of intervals (the 
scale Monotone has just one, viz. 0). The notes so defined are allocated to 
the (mapped) keys repeatedly in a cycle, which may interact unexpectedly 
with an arbitrary sequence of notes. Having precisely 16 defined notes 
prevents this cycling behavior and allows you to match notes to keys one-
to-one. 





5  Setting the lights on buttons and keys 

5.1  To color the octave-down button green 
The octave-down button is the lower of the two octave buttons in this figure: 

 
octave talker hey key 1 colour to 1 set 

 
WARNING: Note the mandatory British spelling: colour for: color. 
 

EXPLANATION: In factory setup pico 1 the octave-down button is 
governed by key 1 of octave talker. This is all you need to know in 
order to alter its color. The talker itself is responsible not only for 
determining what Belcanto gets “talked” when the octave-down button is 
pressed, but also which physical key corresponds to key 1, plus its 
(default) light setting. 

5.2  To toggle the action of  the octave-down button 
Create two files with the contents shown, and place them in the folder: 
/Users/yourname/Library/Eigenlabs/Scripts/ 

Their filenames are immaterial, but to help you identify them later, name them as shown. 
WARNING: Note the mandatory British spelling: colour for: color. 

Text-only file: toggle_octave_0.txt 
 
name 
 toggle octave 0 
description 
 Toggles the octave-down button (key 1) 
script 
 # do desired function here 
main keygroup hey octave up 
 # Change the key color to confirm its mode 
octave talker hey key 1 colour to 2 set 
 # make key 1 action 1 execute the other script 
octave talker hey 1 called 1 cancel 
octave talker hey 
  " interpreter 1 hey toggle octave 1 execute " 
  when 1 called 1 do 
octave talker hey re do 
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Text-only file: toggle_octave_1.txt 
 
name 
 toggle octave 1 
description 
 Toggles the octave-down button (key 1) 
script 
 # do desired function here 
main keygroup hey octave down 
 # Change the key color to confirm its mode 
octave talker hey key 1 colour to 1 set 
 # make key 1 action 1 execute the other script 
octave talker hey 1 called 1 cancel 
octave talker hey 
  " interpreter 1 hey toggle octave 0 execute " 
  when 1 called 1 do 
octave talker hey re do 
 

Where the 2 files differ, we’ve made the words or digits bold+underlined. 
Load factory setup pico 1, and enable this adjustment by typing into 
EigenCommander: 

 
interpreter 1 hey toggle octave 1 execute 
 

Alternatively you can use EigenBrowser to execute one or other of the two scripts. 
If you now press the octave-down button, it changes color to green and 
transposes the scale down an octave. If you press it again, the button 
changes color to red and transposes the scale back up an octave. 

EXPLANATION: Each script performs the opposite function. Each 
also re-programs the octave-down button to execute the other script. Note 
the need for: re do as the last phrase to execute, as recipe 6.4 explains. 
And how to change the color of key 1 is explained in recipe 5.1. 

This pair of scripts can be adapted to toggle the behavior of any key 
or button. And in this case, it frees-up the octave-up button for a different 
use, e.g. to execute some other script. 

5.3  To set the tonic keys of cello rig 1 to green 
Start with factory setup pico 1. 

 
cello rig 1 gateway hey 
  input called light 1 create 
cello rig 1 scaler 1 light output 
  to cello rig 1 gateway light 1 connect 
cello rig 1 light 1 
  to main keygroup keygroup output 6 light input 
  connect 
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Other rigs can be treated similarly. 
 

EXPLANATION: the scaler agent has the built-in ability to identify the 
tonic keys and make the right light output pattern. It just needs 
hooking up to the instrument keys correctly (via main keygroup here). 

5.4  To make the metronome button flash with the beat 
 
metronome hey beat flash persistence to 100 set 
 

Experiment with different values in place of 100. 
 
The value 1 causes a very brief flash, which doesn’t perceptibly lengthen until 50. 
The value 450 is just long enough in pico 1 to make successive flashes run together. 
The value 0 turns off the flash altogether. 
 





6  Creating talkers and setting their actions 

6.1  To see the Belcanto in octave talker 
Every talker links a set of key-presses to actions, which are (compiled) 
Belcanto phrases. So when you press a key, it “talks” Belcanto. 

To see what phrases are “talked” by e.g. octave talker in factory 
setup pico 1, make sure EigenBrowser is running, then enter this phrase 
into EigenCommander (recipe 1.4 shows how): 

 
octave talker phrase browse 
 

You’ll see the following Belcanto phrases appear in EigenBrowser: 
 
main keygroup hey octave down 
main keygroup octave up 
 

ASIDE: The second phrase could just as well have been, 
and should have been, for consistency: 
 
main keygroup hey octave up 
 

6.2  To create a talker named test talker 
 
talker create 
it to test talker name ify 
 

Read: name ify as: “nameify”, i.e. give the agent a new name. 
 

EXPLANATION: If you simply execute talker create, the talker you 
create gets given the name: talker 1. If talker 1 already exists, it gets 
given the name: talker 2. And so on. 

Rather than take a guess at what the name is going to be, it’s best to 
give the talker your own choice of name, e.g. test talker. The noun: 
it refers to the last agent created, without having to name it explicitly. 

6.3  To make test talker talk a Belcanto phrase 
 
test talker hey 3 called 2 cancel 
test talker hey 
" metronome hey toggle start " when 3 called 2 do 
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As we see in recipe 6.1  the purpose of a talker is to “talk” Belcanto 
whenever a given key is pressed. But you don’t need a separate talker for 
each key: the same talker can govern several keys, each talking a different 
Belcanto phrase (called the action). Moreover a given key can have not 
just one but an unlimited number of actions, done one after the other. 

Why is there a need for one key to be able to have more than one 
action, when any sequence of Belcanto phrases can be strung together into 
a single action? To allow actions to be added and deleted independently of 
each other. 

The upshot is: when telling test talker what action to take (or 
“talk”), you need to specify both a key ID number and an action ID number. 
Usually a talker has keys numbered 1, 2, 3, ... and each key has actions 
numbered 1, 2, 3 (rarely more). But the numbers don’t have to be con-
secutive. Thus key 2 can have an action 2 without it having an 
action 1, or there being a key 1. So: 

 
" metronome hey toggle start " when 3 called 2 do 
 

means: let action 2 be: metronome hey toggle start – and let it be 
done whenever key 3 is pressed. 

Why is the metronome phrase put in quotes:  " ... " ? Because it is not 
Belcanto to be executed here-and-now, but a string of (Belcanto) words 
for attachment to action 2. This string will not be executed as Belcanto 
until later, when key 3 is pressed. 

Note that the quotes are themselves Belcanto words. So it is good to 
surround them with whitespace. 

You can also use single-quotes. That allows you to define a string inside a string. 
Why start with: test talker hey 3 called 2 cancel ? The 

recipe will probably work without it. But to avoid mis-compilation it’s 
wise to delete any action 2 which happens to be there already. 

Which key is key 3? You’ll need to set it to a physical key (e.g. row 3 
of column 2) like this: 

 
test talker hey 
  key 1 key column to 2 set 
test talker hey 
  key 1 key row to 3 set 
 

6.4  To recompile the actions in test talker 
 
test talker hey re do 
 



 

 

37 

On its own, re do recompiles the actions in all talkers in the current setup. 
 

Why might you ever want to do this? To fix a talker’s misbehavior. 
A talker’s action isn’t just a string of Belcanto. It’s compiled whenever 

the action is created or altered. Sometimes during experiments, compil-
ation can get out-of-step: a given key doesn’t perform the action that 
EigenBrowser says it should (see recipe 6.1). 

Sometimes you know from experience you’re going to fool the Bel-
canto interpreter. In that case, execute: re do at the end of your action or 
script. 





7  Filtering audio and recording sounds 

7.1  To record the sound produced by the Eigenharp 
Start recording: 

 
audio hey recorder set 
 

Stop recording: 
 
audio hey recorder un set 
 

This writes a sound file named audio.wav in the folder: 
/Users/yourname/Library/Eigenlabs/2.0.74-stable/Audio/ 

Replace yourname with your own user name, and if you are running a different version 
of EigenD replace 2.0.74 with the version of EigenD you are running. 

If audio.wav is already there, it is overwritten. So if you want to keep 
the recording you’ve just made, then move audio.wav out of its folder. 
Alternatively, rename it, or duplicate it. 

7.2  To silence and restore the audio signal 
audio hey mute 
 
audio hey un mute 
 

Used in conjunction with recipe 7.1 the first phrase silences the audio 
signal but does not stop the sound file being written. These two phrases 
used in succession will introduce a period of silence into audio.wav 
without disrupting the timing. 

7.3  To coarsen or refine the sound recording 
audio hey sample rate to 44100 set 
 
audio hey sample rate to 48000 set 
 
audio hey sample rate to 96000 set 
 

Each of these phrases redefines the internal sampling rate: the choice 
being between 44.1 kHz, 48 kHz and 96 kHz. This governs the size of 
the sound file created by recipe 7.1. 

The factory setup pico 1 starts with a sample rate of 44100, at 
which rate 10 seconds of recording makes audio.wav a stereo file of 
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3.5 MB. Setting sample rate to 48000 makes audio.wav 3.9 MB, and 
setting sample rate to 96000 makes audio.wav twice the size: 7.8 MB. 

7.4  To calculate the expected size of  a sound recording 
Use this formula for the size of audio.wav created by recipe 7.1: 
 (file size) = (duration) × (channels) × (sample rate) × (sample size) 

• duration (seconds) 
• channels = 1 (mono) or 2 (stereo) 
• sample rate = 44100, 48000 or 96000 (samples-per-second) 
• sample size = 4 bytes (most audio software uses 4-byte samples). 
= 10 * 2 * 44100 * 4 

This is code suitable for Microsoft™ Excel or (without: =) into Apple® Spotlight. 
= 3,528,000 bytes (or 3.5 MB). 



Appendix A:  Glossary of technical terms 
 
This is an alphabetical glossary of terms used in the foregoing chapters, 
which may be unfamiliar to the non-technical reader. All such terms are 
formatted in the narrative like this: agent. This tells you that an explanat-
ion of the term can be found below. 

 
 

 
About Window: the banner window that appears when you click the 
mandatory menu item in all Macintosh apps: About [App-name]... 

Contains essential information about the version/release of the app 
that is running. Essential for recipe 1.5. 
 
Action: one of a choice of Belcanto phrases executed by a given talker 
when certain keys or buttons are pressed. Every action has an ID number, 
viz. action 1, action 2, etc. 
 
Agent: a component of EigenD. Agents are responsible for all the 
functionality of EigenD. Individual agents may be supplied by the vendor 
(www.eigenlabs.com) or by some third-party. You can write your own. 
 
App, Application: a program or suite of programs running on the 
Apple® Macintosh™ that is not part of MacOS itself. Usually a 3rd-party 
vendor program, or even one written by the user. EigenD is an app, but 
EigenCommander and EigenBrowser aren’t, or shouldn’t be, even though 
they’re written to look and feel like apps. 
 
ASCII (American Standard Code for Information Interchange): the 
oldest, most primitive digital character encoding, still employed by all 
personal computers. 
Its importance to this Cookbook is that Belcanto is written using only 
ASCII characters. A Belcanto script is a text-only file of the simplest sort. 
Non-USA users should be warned that ASCII contains the 26 Latin 
letters in both upper and lower case: A-Z and a-z, but no accented or 
national characters such as: é æ ø å. It contains $ but no other currency 
symbol, not even £. 
The printable ASCII characters are:  

!"#$%&'()*+,./0123456789:;<=>? 
@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_ 
`abcdefghijklmnopqrstuvwxyz{|}~ 
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We must stress that these are the only characters (apart from whitespace) 
that can appear in a script. 
ASCII existed long before computers were invented. Originally it was a 
teleprinter coding standard, and therefore provides some historical (non-
printing) byte-codes for controlling the teleprinter itself, even including 
ringing the bell! Some byte-codes are still in use by personal computers, 
notably Null (NUL), Linend (LF) and Carriage Return (CR). 
Present-day computer platforms also support a multi-byte standard called 
Unicode, of which ASCII has been reduced to a subset, albeit a privileg-
ed one (viz. as the first 128 numeric character-codes, the so-called code 
points). 
 
Belcanto Interpreter: an agent that is responsible for compiling and 
executing Belcanto code. 
 
Comment: a line in a script which the Belcanto Interpreter ignores. It serves 
only to convey some message to the programmer or musician. 
Comments in a script must begin with the character: # 
 
Context-dependent: Lacking the property of being context-free, often 
conspicuously so. 
 
Context-free: used to describe a computer language in which a statement 
is either valid or invalid, independently of the context, i.e. what has 
already taken place. Belcanto is NOT context-free, not even for 
determining valid syntax. 
 
Custom scale: a musical scale defined by the user, extending the set of 
scales available for the Eigenharp. See recipes 4.5 and 4.6. 
 
Dock: a bar of application icons at the bottom of the Macintosh screen 
for launching frequently-used programs (apps). 
 
EigenBrowser: an agent that displays a dynamic menu on the computer 
screen, letting you select and load sounds and loops, and run both factory 
and user-written scripts. To help you adjust the Eigenharp on-stage, you 
can control the menu contents, and pick a desired menu item by using 
the instrument keys alone. 
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EigenCommander: an agent that displays a session record on the 
computer screen, letting you type-in a Belcanto phrase and see the (error) 
response if it is not executed. 
 
EigenD: the software that drives the Eigenharp. A given release of 
EigenD serves all Eigenharp models. 
 
Extension: the last part of a period-separated filename. Thus suppose a 
file is named: My.txt.only.script.txt – the last part (and only that 
part): txt is the extension. Some programmers don’t consider the 
extension as part of the filename proper. MacOS even has a user option 
to hide it in Finder windows. 

The extension is essential under Windows for determining the type 
and ownership of any given file. It is not essential on the Macintosh, 
which has its own hidden way of recognizing the type of a file, but 
MacOS is gradually coming to accept the extension as overriding its own 
type-mechanism. 

In practice, appending the extension: txt to the name of a text-only file 
signals to both system and user that it is an appropriate container for a 
Belcanto script. However the extension: txt is not mandatory for a script, 
nor is any other extension. This is an idiosyncratic state-of-affairs, with 
many subtle consequences for the Macintosh user. 
 
Factory setup: one of a number of setups distributed with EigenD. Some 
are experimental, being offered as a basis for writing your own setups. 
Others are standard setups. The vendor offers these for immediate on-stage 
use, having extensively developed them for the purpose. However these 
too can be used as a basis for your own setups. 
 
Filename: the name by which the computer platform (MacOS or 
Windows™) knows a given file. A Belcanto script has a filename, but it 
can also have a Belcanto name that is different. See: Name, Extension. 
 
Header: the leading section in a script that describes what it does. This is 
mandatory, even though it is not executed by the Belcanto interpreter. It 
starts with the word: name or description and finishes with the word 
script. Unlike Belcanto itself, whitespace does matter in the header. In 
particular, name, description and script each needs a line to itself. 

 
name 
 test name 
description 
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 This section describes what the script does, 
 viz it starts/stops the metronome. 
script 
 metronome hey 
 toggle start 
 

The name section is needed if you want to execute the script using a 
Belcanto phrase. The name needs to be a valid Belcanto noun (the 
filename won’t do). You can then execute the script as follows: 
 

interpreter 1 hey test name execute 
 
The name section may be placed above or below description. Or it can 
be omitted, e.g. 

 
description 
 This section describes what the script does, 
 viz it starts/stops the metronome. 
script 
 metronome hey 
 toggle start 

 
ID number: a single number used to identify keys, agents and actions. 
 
Menubar: a bar at the top of the MacOS screen, containing menus for 
interacting with a given application, specifically EigenD.  

Unlike Microsoft Windows™, MacOS shows only one menubar at a 
time, and that belongs to the application that has one of its window 
currently selected.  

Because of how EigenD is written, it is a user-unfriendly task getting 
the correct menubar to appear in order to save a setup, say, or launch a 
daughter app. You must get in the habit of first automatically clicking the 
EigenD icon in the Dock, as opposed to one of the icons of the daughter 
apps: Workbench, Stage, EigenCommander or EigenBrowser, which all look 
identical. 
 
MIDI (Musical Instrument Digital Interface): a popular electronic 
musical instrument connectivity standard. EigenD does not use MIDI 
itself, but can configure the Eigenharp to behave like a MIDI instrument, 
e.g. for connection to Apple® GarageBand™. 
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MIDI number: a specification of precise musical pitch agreed to by the 
MIDI Manufacturers Association in the MIDI protocol. Also known as 
the MIDI Tuning Standard (MTS). 
See: www.en.wikipedia.org/wiki/MIDI_Tuning_Standard  
Sample MIDI numbers: 

• Concert Pitch A440: 69 
• G below Concert Pitch A440: 67 
• Concert Middle-C (261.6255653 Hz): 60 
• Perfect 5th above Concert Middle-C: 67.01955001 
• Scientific Middle-C (256 Hz): 59.62368344 

 
MTS number: see: MIDI number. 
 
Musical mapping: a user-specifiable rearrangement of the keys within a 
block (defined by some given physical mapping). With the Pico, all key 
arrangements are governed by some choice of musical mapping, not physical 
mapping. See recipes 4.1 to 4.4. 
 
NotePad: a Microsoft™ utility which provides the prime means under 
Windows™ of creating and editing text-only files. See also: TextEdit. 
 
Noun: a word in Belcanto, or string of words, denoting an object as 
opposed to a verb, e.g. 

 
all 
octave talker 
key 9 
keygroup 1 
 

Octave buttons: two buttons on the Pico which are used in the factory 
setup pico 1 to transpose up/down by one octave. 
 

 
There is nothing built-into the physical Pico instrument which says they 
must be used to transpose the key by an octave. This behavior is simply 
part of the factory setup pico 1. To Belcanto, and to Workbench, these two 
buttons are “keys” in a notional “column 3”, numbered 3 and 4. You use 
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these numbers to identify the physical key to perform an action when 
creating a keygroup agent. 
 
Octave-down button: the Pico octave button adjacent to the strip control. 
Can be addressed as the “key” at column 3 row 3. 
 
Octave-up button: the Pico octave button placed centrally. Can be 
addressed as the “key” at column 3 row 4. 
 
Octave factor: a fraction which specifies a musical interval in terms of 
what proportion of an octave it represents. See recipe 3.2 for a table of 
octave factors. 
 
Open-source: freely available software guaranteed to contain no 
proprietary component, maintained cooperatively by volunteers as part of 
a web-based group. 

See: http://en.wikipedia.org/wiki/Open-source_software  
 
Phrase: a valid piece of Belcanto code, which works on its own in 
EigenCommander. Sometimes used to mean a single line of a script (but see 
below: whitespace). 

A phrase must always end with a verb, for example: hey as in: 
 

metronome hey 
 
Physical mapping: a user-specifiable mapping of the keys of the 
physical instrument to divide them into blocks for different purposes. 
Typically the Pico is not divided into blocks in this way, so only one 
physical mapping is ever used. See: musical mapping. 
 
Pouf: to pouf an icon is to remove it permanently from the MacOS Dock. 
So-called because dragging/dropping an icon sufficiently far away from 
the Dock causes it to disappear with a “pouf”-sound in a puff of smoke. 
 
Script: a text-only file of Belcanto, together with a descriptive header. For a 
sample script, see: Header. 
 
Setup: a file, or collection of files, recording the overall internal status of 
EigenD at the time the setup was saved. 

A given setup has a name (must be in Belcanto syntax) e.g. user 9 
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EigenD shows you a list of the setup names it knows about, for the 
purpose of re-loading to restore the desired internal status. These include 
a number of factory setups distributed with EigenD. See: Standard setup. 

The term setup is also used loosely to mean the internal state of EigenD 
at any given instant, regardless of the (named) setup having been saved 
(or updated). Executing a Belcanto phrase alters the current setup, as thus 
understood. So does the use of Stage and/or Workbench to create, config-
ure and connect agents. 
 
Spotlight: a MacOS utility, activated by ⌘spacebar, which explains 
technical terms, searches for files by name or content, or calculates 
expressions (see recipe 7.4) such as: 

10 * 2 * 44100 * 4 
3528000 

 
Stage: a program distributed with EigenD that lets you control the 
Eigenharp on-stage by means of buttons and dials shown on the 
computer screen. Stage can run on a remote computer, e.g. MacBook™ 
or iPad™, connecting to EigenD by means of HTML. 
 
Standard setup: one of a number of factory setups distributed with EigenD. 
Most of them are appropriate only for one model of Eigenharp, Alpha, 
Tau or Pico. Pico owners seem to feel the greatest need to customize 
their instrument, so the examples in this Cookbook are primarily 
addressed to them. So the main standard setups used in this Cookbook 
are pico 1 and blank. 
 
Talk: the action of a talker when one of its associated keys or buttons are 
pressed. 
 
Talker: an EigenD agent whose main purpose is to execute a given Bel-
canto phrase, or series of phrases (the talker’s actions) when some key or 
button is pressed on the Eigenharp. A talker also governs the lights on its 
associated keys. 
 
TextEdit: a Macintosh™ utility which provides the prime means under 
MacOS of creating and editing text-only files. See also: NotePad. 
 
Text-only file: a data file of the most elementary sort, invented at the 
dawn of the (IBM) personal computer. Its name has extension: .txt and 
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it consists solely of ASCII characters, which may or may not contain 
whitespace characters. 

Text-only files are created and altered (“edited”) on the MacOS 
platform by the utility: TextEdit, and on MS Windows™ platforms by 
the utility: NotePad. 
 
Treeview: a data display in a branching form, allowing branches to be 
hidden or revealed. 

Sample treeview display: 

 
 
Unicode: a collection of related standards developed and maintained by 
www.unicode.org for representing the graphemes of all the world’s 
writing systems as multi-byte “code points” (loosely: “characters”). One 
standard in particular, utf-8, is now well-supported by most computer 
systems and apps. It permits an otherwise conventional text-only file to 
contain non-ASCII characters. See: ASCII. 

A utf-8 character may appear in the header of a script, but Belcanto 
syntax is ASCII-only and cannot validly contain unicode characters. 

This has implications for the use of extended-Latin characters in 
European languages, e.g. æ å ø á ñ, plus some currency signs. Thus $ is 
an ASCII character, but ¢ (also used for musical cents) is not. 
 
Unix: a venerable yet still popular computer operating system. MacOS is 
built as a layer on top of Unix, and any Macintosh computer can be 
operated via a Unix session provided by Terminal.app. Windows™ has 
no built-in support for Unix. 
 
User setup: a setup created and saved by the Eigenharp user. EigenD 
keeps user setups at arms-length from factory setups. 
 
Verb: an activity word in Belcanto, e.g. connect hey set start 
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Version folder: a folder of system files specific to a given version of 
EigenD. For version 2.0.74 this folder is named: 
/Applications/Eigenlabs/2.0.74-stable/. 
 
Whitespace: refers to those non-print ASCII characters which are there 
to control the original teletype, or in present-day terms, to format the 
code layout. For example, the unseen character(s) known to 
programmers as carriage return (0x0D) and linend (0x10)), that you make by 
pressing the Return key. 

The Belcanto interpreter treats all whitespace characters as if they were 
the space character (0x20) which you make by pressing the Spacebar. The 
space character itself is not a word as such. It only separates words. It 
does not have a representation as musical notes. However carriage return 
and linend do matter when creating comments (serving to terminate a 
comment), and also when creating the header in a script. 
 
Word: a lexical unit, or token, of Belcanto syntax, e.g. connect hey 
set start un.  

These punctuation marks are individual words:  " ' , - . `  also 
the digits:  0 1 2 3 4 5 6 7 8 9. Apart from these, all words must be 
one of 700 or so in the dictionary that EigenCommander shows you. Every 
word in the dictionary has a representation as a sequence of musical note 
(which EigenCommander also shows you), or informally as note-numbers, 1 
to 8. 

Every word is separated from the next word by one or more whitespace 
characters. The only exception to this rule are those words consisting of 
punctuation or digits, which the Belcanto interpreter knows how to 
separate, and combine again. Thus the number in recipe 3.2 i.e. 0.5 is 
strictly not a single word but three, viz. 0 . 5 
 
Workbench: an agent that lets you view and modify the current EigenD 
setup as a collection of boxes (one for each agent) and cable connections. 
Use of Workbench creates, connects and configures agents. The EigenD 
program itself can then be used to save this internal status as a (Belcanto-
named, reloadable) setup. 
 





Appendix B:  Selected Language Reference 
 
This is a list of selected Belcanto words. We haven’t shown them all here 
(there are over 700), just the main ones, especially those that may not be 
obvious to the beginner. Thus a Belcanto word like octave needs no 
explanation to a musician, whereas ify and un might well do so. 

EigenCommander shows a list of all such words, along with their repre-
sentation as “musical notes” to be used when entering Belcanto via the 
physical instrument keyboard. 

 
 
# 
Starts a comment in a script. 
A comment must have a whole line to itself. 
(But # can be preceded by whitespace.) 

 
# Include keygroup 1 in the present conversation 
keygroup 1 listen 

 
 
add 
Creates an additional attribute of an existing agent. 
See example in: key. 

 
 
all 
Used to refer to all agents, or all instances of a given agent. 
See: join. 

 
 
called 
Refers to an attribute of an agent by its ID number. 

 
octave talker hey 1 called 1 cancel 
 

 
 
cancel 
Removes an action from a talker agent. 

 
octave talker hey 1 called 1 cancel 
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column 
(With: row) specifies the location of a key identified by an ID number. 

 
test talker hey 
  key 1 key column to 2 set 
test talker hey 
  key 1 key row to 3 set 
 

See also: row. 
 

 
connect 
Connects the output of a given agent to the input of another given agent. 

 
player key to sampler rig 3 key connect 

 
 
create 
Creates a given type of agent. 

 
player create 
 

The agent so created will have the name: player 1 (or the next unused 
number). To give it your own choice of name, e.g. note player, use: 
name ify. 

 
 
empty 
See: join. 

 
 
from 
Noise-word used to separate nouns in a Belcanto phrase. 

 
player key from sampler rig 3 key un connect 

 
 
hey 
Used to start a conversation with a single named agent. 

 
metronome hey 
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If you want to start a conversation with several agents at once, then use 
the verb: listen. 

 
 
ify 
Used to make a verb out of a noun. 

 
talker create 
it to octave talker 1 name ify 

 
 
it 
Refers to the just-created agent just created, usually in order to give it your 
own choice of name. 
See also: ify. 

 
 
join 
Includes agents in a conversation. 
To start a new conversation with all agents: 

 
all join 
 

To start a new conversation with no agents (agents will subsequently be 
added using: listen): 

 
empty join 

 
 
key  (formerly: k) 
Stands for a given key on the physical keyboard. 
Must be followed by a single ID number. 
(Specify which physical key you mean by using: row and column.) 
  

output 1 create 
 output 1 choose 
 key 1 add 
 key 2 add 

 
Example (used with all): 

 
all scaler hey  
all key bend range to 2 set 
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keygroup  (formerly: kgroup) 
An agent that controls the behavior of a subset of keys. 

 
 
listen 
Recruit several agents one-at-a-time into a conversation. 

 
empty join 
keygroup 1 listen 
keygroup 2 listen 
 

See also: hey. 
 

 
row 
See: column. 

 
 
set 
Assigns a value to the attribute of a given agent. 

 
octave talker hey key 1 colour to 1 set 
 
all scaler hey 
all key bend range to 2 set 

 
 
to 
Noise-word used to separate 2 nouns. 

 
player pressure to sampler rig 3 pressure connect 
 

C/f: from. 
 

 
un 
Used in front of a verb to negate an action, e.g. to disconnect a connection. 

 
player key from sampler rig 3 key un connect 
 
 
 



 

 

55 

 
 
when 
Used in a phrase to link an action to a talker agent key. 

 
octave talker hey 
  " main keygroup hey octave by 0.5 down " 
  when 1 called 1 do 
 


